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USER GUIDE

Introduction

This User Guide is designed to serve as a brief overview to help you get started. There is also information available under the Help
option in the various Contributor interface toolbar. If necessary you can access the Help by launching the Contributor interface from
the System Tray and selecting Help->Help and Support.

If you would like further instructions, please consult the Features list at http://support.colligo.com/Lists/Features/Allltems.aspx -
where you will find a complete list of features by product along with instructions for use. You will also find a number of screencasts
on the support site that walk you through the main product features. The SharePoint support site can be synchronized with Colligo
Contributor for anytime access, online or offline. Please follow the instructions on the home page at http://support.colligo.com/.

We hope you enjoy using the product, and please don’t hesitate to send us questions or provide feedback at support@colligo.com.
Thank You.
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Installing Colligo Contributor
Systems Supported

. Microsoft” Windows 7 Home Premium; Professional or Ultimate.

. Microsoft’ Windows' Vista Business; Enterprise or Ultimate.

e Microsoft Windows XP Home or Professional

e Microsoft Windows 2000 Service Pack 2 or greater

e  Microsoft Office 2000 — 2007 (Office 2003 SP2 or later for InfoPath forms)

e Internet Explorer 6.0 or later

° WSS (2.0 or 3.0) and SPS 2003 and MOSS 2007

e  Consumes roughly 20MB of disk space, not including content

e If you have a previous version installed, the new version can be installed “over top” of the old version without needing to
uninstall. This will also preserve all of the cached content.

Application Prerequisites
e  .NET Framework 2.0
For XP or 2000, please ensure the .NET Framework 2.0 is installed first (included with Vista). You can check in the Control
Panel > Add/Remove Program.
e  .NET Framework 3.0
Required to support embedding and extraction of metadata from Office 2007 documents.

Outlook Add-in Prerequisites
e  Compatible version of Outlook (Outlook 2003 or Outlook 2007)
e  Office 2003 or Office 2007 Primary Interop Assemblies (depending on which version of Office is installed)
e  Microsoft Visual Studio 2005 Tools for Office Second Edition (VSTO 2005 SE) Runtime
e  Microsoft Visual C++ 2008 SP1 Redistributable Package

Interactive EXE Install
1. Download the Colligo Contributor EXE installation file to your local computer.
Double-click on the installation file to install Colligo Contributor.
Prerequisites are downloaded and installed.
Enter your license key.
Colligo Contributor can be set to launch at Windows Start Up. This will enable the background synchronization to start
automatically.
Interactive MSI Install
1. Check and ensure the prerequisites are installed.
2. Download the Colligo Contributor MSI installation file to your local computer.
3. Double-click on the installation file to install Colligo Contributor.
4.  Enter your license key.

vk wnN

Terminal Server Install
For information on installing in a Terminal Server environment see the Colligo Contributor Terminal Server User Guide

Other Installation Options
More details on installation are available on the support site:
http://support.colligo.com/Lists/Knowledqge%20Base/DispForm.aspx?ID=16

Notes

e  Concurrent version installations
Colligo does *not* support side-by-side installations, running multiple versions or different versions of Contributor.
Version reversion/downgrading
It is *not* possible to revert to an earlier version of Contributor after upgrading as the database is often updated.

e Microsoft Windows 2000
Microsoft Office” 2007 is *not* supported on Microsoft” Windows 2000. Contributor does *not* support metadata
embedding and extraction from Office” 2007 documents on Windows 2000 systems.

April 14, 2010 Copyright 2010 Colligo Networks, Inc. All rights reserved. Page 4 of 29
Not to be reproduced without permission. Learn more here www.colligo.com.


http://www.colligo.com/_documents/Colligo_Contributor_Terminal_Server_User_Guide.pdf
http://support.colligo.com/Lists/Knowledge%20Base/DispForm.aspx?ID=16

The Desktop Client

Adding a Site to Contributor

User Guide — Colligo Contributor v4.1 Pro

It is possible to add a site to Contributor in a number of other ways, including:

Use the “Connect to Contributor” option in Internet Explorer
Site -> Download Site menu option
Click the site selector drop-down and select “Download Site...”
Drag and Drop a URL from IE Into Contributor

The simplest approach is using the “Connect to Contributor” option. This process is described below.

Step 1: IE Toolbar button “Connect to Contributor”

Navigate to a SharePoint site in Internet Explorer
Click the green “Connect to Contributor” icon on the toolbar

Step 2: Enter your credentials

/€ Project Tracker - Windows Internet Explorer

lolfEEs)

@ @ v ‘g http://server/bsbev/Issue%20Tracker/Fort v l s | X

W ‘ (& Project Tracker

P ~|

Live Search

| B v B v @ v Page v {3 Took v 7]

j B's Beverages > Project
[ view Al site Content

Documents Upload ~

New ~

= Initiate

ype  Name

Tracker
Project Tracker
] VUse this !iBrarv to store forms, reports andreméds reléung to issues.

Actions ~ Settings ~

" @ Help
éZl Send to OneNote
&l Research

(v Connect to Outlook

v

View:

1 Connect to Contributor

Issue

Contributor will prompt you to enter your credentials for this site. You may use default windows credentials or enter other specified

credentials.

y Download New Site

Site: | <ew Site>

URL:  http://server/bsbev

http://
https:/,

Server Authentication

Examples:

©) Use default credentials
() Use the following credentials:

User name:

Password:

fworkspace
cureserver fworkspace

[ Download ]

[

Close

Contributor will access the SharePoint web-services and request a list of Lists and Libraries you have access to.
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Step 3: Choose the lists to sync

Once Contributor has received the list of Lists you are able to select which Lists you which to synchronize.
You may choose to:

e Synchronize all document libraries and lists.
e Synchronize specific lists (described below)
Select the lists you wish to Synchronize by ticking the box next to the list in the “Select for Synchronization” dialog.

Step 3.1: Apply Sync-Filters
You may apply a filter to each list to restrict cached content. Available filters are
e Allfolders or specified folders. All subfolders will also be synchronized.
e Acollection of Views. Contributor will synchronize all content selected in any View.

The “Select Filters for Synchronization” process is shows below:

Select for Synchronization =
Document Libr: nd Lists. ——
T Select Fiters For Synchronization =]
Synchronize al document lbraries and Ists
@ Syndworize the folowing: Disable Synchronization for this Document Libeary
‘ g 7 Synchronize Entire Document Library
| [ nvoices
° filters:
B B iy Only synchvonize content based on the following fiters:
[F] [l Miestones Syndhronized Folders
£ Comowcs T soecegroen |
[T] EProject Announcements. =0/ (3 fClent Df Select for Synchronization 3
IE}  Project Calendar 3
= - - Document Libraries and Lists
[] (31Project Emais and Documents = [ Issue Archive Folder >
[F] (2 Project Management Links B Status Reports [ add>> | Synchronize all document ibraries and ists
[] iProject Photos ” @ Synchronize the following:
[ romc e i z
[7] sdResources = 1 [l open Projects
enable or disable synchr / 4§ Project Announcements.
/ [ [ Project Calendar
Uncheck Al Ii Fiter... JR e 7] (L Project Emais and Documents
- [avasabevens ] s ssenet ot
—— N. [T Al Issues []My Doaut [ () Project Photos 4
Smvonee ) o) 6l i proect race | -
1) Group By Leader Add >> 2] £1) Project Track
s Coamers
TMy Tssues Remove / 23 Client Docs Folder
[TProject Status Ml Resources -
ckbox to enable or disable synchronization for
=
cose |
Step 4: Synchronize content
Contributor synchronizes the selected content.
Synchronization In Progress =]
Site List: Site: §8's Beverages
% §f5s Beverages Server: D http:/Jsupport.coligo.com/bsbev
Synchronization Activity
Current List: g Site Design
Status: Completed successfully.
Received: 14of 14 Sent: 000
Working ...
== EiEnrE=]
he Issues
Close this window¥ghen synchronization completes
— Jient Docs Folder
| ¥J Project Tracker
Documents » || use this ibrary to store forms, reports and emails relating to issues.
| New ~ | Upload ~ | Filter + View:  All Issues =
| Name Issue  Status
[ Financial Statements
SR [= Le1600_Spec_us.pdf com...

8] sharepoint v2revie... Test...
3 Client Docs Folder 2

Pictures

n

= Open Projects

@ Last Synchronization: 25/02/2008 7:58:49 PM

Once Synchronization is complete you are ready to start working with cached content.
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Editing content

Open a document by double-clicking on the item
Right-click on an item to:
e  Edit the properties (metadata) of the item.
e  Open/Edit a document
e  Check Out; Check In; or Discard Check Out
. Rename content
e  Delete content

@ Colligo Contributor Pro 4.0 [P %)
File Site View Help
Site: §ifi B's Beverages ~ | [2) synchronize... ~ | @ View Sync Issues
- B's Beverages > Initiate
| ] nitiate
Documents -

Use this document library to share and collaborate on project initiation documents, This document library can contain Proposals,
Statements of Work, and Kick OFf documents.

= Initiate Mew v | Upload ~ | Filter + View:  All Documents  ~ | 1]

Name Created Testing
L MyTestFolder 7/9{2009 1:40 PM
[ EmptyForhlow 7/9/2009 3:20 PM

6/3/2008

5/30/2008
Pictures =

1 webC| . Open with Microsoft Office Word
#ronq i) Edit with Microsoft Office Word 5/29/2008
3 Hello.q — | 5j29/2008
5 meow| &1/ Check Out 5/29/2008 £
weng @ Copy SharePoint URL
) Fax 5/29/2008

||| Eesee Rename 5/29j2008
1 Helmu| % Delete
(1 _265ep07 12.51,62_Test... 10]16/2007 10:48 PM
I Helmut Schuler_190ct07 ... 10{18/2007 10:54 PM

T LB callion_contributar doc {2a{20N8 10:14 PA %

@ Last Synchronization: 7/26{2009 11:22:27 PM

Creating new content
New content can be created by selecting the “New” option.
On SharePoint 2007 site content can be created based on content-type templates.

(@) Colligo Contributor 3.0 Professional o5 =
File Site View Help
site: 4 B's Beverages ~ | [2) snchronize... ~ | @y View Sync Issues
— B's Beverages > Project Emails and Documents
[ - Project Emails and Documents
Documents » || store project emails in here to keep track of communication. |
New ~|| Upload ~ | Filter ~ View: | All Emails ~|.m |
= B Email (Hidden Fields) To From Project |
= Project Emails and P -
Documents @) emai . —| | :
= Project Tracker Project Status Report ] Create New Project Status Report X
[ Client Docs Folder Folder Site Templates m
Pictures
=l #
Li 4 celebration Lunch Friday *helmut@ ProjectStatus
i celebration Lunch Friday *helmut@y Report
£ MetaTags Issue Barb Sanl
4 Team Meeting Barb Sani
L4 Oustanding Issue Barb Sanl
1 Re: Oustanding Issue Barb Sanl
] Re: Oustanding Issue Barb Sanl
" Open Projects | & i Latest Issue Report Barb Sanl
L4 Latest Issue Report Barb Sanl
~|| < Fs i
Please enter a name for this new document:
New Document
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Uploading existing content

Using “Upload Documents” menu

Existing content can be added to Contributor by selecting the “Upload” option:
Contributor will prompt for metadata when the document is uploaded.

(@ Colligo Contributor 3.0 Professional == Fon <~
Be Ste Vew Hep
Site: 3 8's Beverages ~ | [2) snchvonize... ~ | @ View Sync [ssues 2| Project Emails and Documents: New Item =)
= B's Beverages > Project Emals and Documents Document
|EE | Project Emails and Documents {3 Veta Togs Reportdocx
tew ~ | [Upload ~| Fiter ~ View: | All Emails = Wi Folder
Type [ Upload Documents To From Project ‘ &/ i [‘Browse... |
* Project Emalls and 3 -
Documents G 7 Propertes
* Project Tracker &) ssee ‘3\ Content Type: ~Project Status Report -
< Client Docs Folder Eﬂ et
= i
& k in: Project Do v
Pictures. & ' Ypc Loy 67 Meta Tags Report. docx
=l = T Neme Date modif... Type Size -
s ‘ | Celebration Lunch Friday - 5] Meta Togs R = —
1 Celebration Lunch Friday Recent Places ) cpatus for Demo.doox =
‘ A MetaTags Issue & Testdocx
= Team Meetng ’
H outnanisae |
=4 Re: Oustanding Issue Desktop
‘ 4 Re: Oustanding Issue
% OpenFyopcs 1 Latest Issue Report ™
] |
< Latest Issue Report ‘
vilel i David
i
Cancel
Computer
x Fie name Meta Tags Report docx -
.
- Fies of type: (A0 Fies 0 - Cancel

Upload content with drag-and-drop

Alternatively you can drag and drop content into Contributor from your desktop. Contributor will accept one or more files or
complete folder structures for uploading. Contributor will prompt for metadata when the items are uploaded.

g (3 Colligo Contributor 3.0 Professional o lfe=s

File Site View Help

Recycle Bin

Site: § B's Beverages ~ | [&) sunchronize... ~ | @ View Sync Issues
— B's Beverages > Project Emails and Documents
R Project Emails and Documents

Documents || store project emails in here to keep track of communication. |
Colligo New ~ | Upload ~ | Filter ~ {3} Project Emails and Documents: New ltem =1
Contribut...
20008 Type Subject To Document
® Project Emails and -
hCts o Latest Issue Report Barb Sankovic &_ Meta Tags Report.docx
W, j
] LatestIssue Report Barb Sankovic = ft Off
® Project Tracker @ 2 6,314 S
(22 Cli Fol
S Bocsakier 4 Re: Oustanding Issue Barb Sankovic Folder
4 Testing Complete ‘barb@contoso.com' ‘Lj / [ [ Browse... J
= L Team Meeting Needed ‘barb@contoso.com’; 'fred@
" Properties
] LatestIssue Report Barb Sankovic
weQustanding Issue Barb Sankovic Content Type:  |Project Status Report ']
Name *
£ Returned Mail Meta Tags Report.docx
l:—ﬂ Meta Tags Report.docx -
= Titl
&) S B
Ee
4 Last chance to join 60,000 pe... Barry Jinks
. -
SpeaFrojects lﬂ] Project Status Report.docx
E‘_] Project Status Report.docx
~|[«] m ]
@ Last|
[ Create ] l Cancel
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Copying existing content

Drag-and-drop

Existing content, files or folder structures, can be copied between SharePoint document libraries or folders by a drag and drop
operation. A new copy of the files or folders is created in the destination location and Contributor will prompt for metadata. In cases
where the metadata structure in the destination library is different from the source library Contributor will make a best effort to
match and retain existing metadata values.

Share Content with other users

Copy SharePoint URL

You can share content with other users by right-clicking on an item and selecting “Copy SharePoint URL”, URLs for the selected
item(s) are copied to your clipboard and can be pasted into many applications, files, or emails.

Drag-and-Drop

Alternatively, for users that do not have access to the SharePoint site it is possible to drag and drop files or folder structures from
the Contributor Client into a Windows folder, a file, or as an attachment to an email.

& Caligo Cortrisutor 12 Pen
B 9= Pev teb

Ste: §ifi 6's Beverages v 3) Serovonae.. - | @ ew Sy sues

2 Beverages > Projgect Emals ard Docarents

Project Emails and Documents

v | cad v Pler « Ve AR Camathe

Subrmct T> From
wa! UUSTanOng iS5 BAD SRV T ST

Rei Oustanding lssue Bard Sankoaic Hedont Schubes

Latest losue Report Bard Sankowvic Helnut Schuler

Latest ksue Report Bard Sanboc Hetnut Schuler

ITT Case Sty Helnut Schuker

Re1 Qustanding lssue Bard Sankonic on Gagvd

Testng Corplete D DPCONIIE0 LN 3o O pes

Tears Meetng Needed DaDSone o ‘Ted @ . I Dvper

Latest sue Repart Bard Sanbowac Jobny Sewth

Bard Sarbon Kale Mool

£t Propertes... ‘.n:mu'

|

beieut Schuler

bear b taorkrg com

7 T re el @ Coir
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The Outlook Add-In
Adding a Site to Outlook

It is possible to add a site to Contributor in a number of other ways, including:
e Use the “Connect to Outlook” option in Internet Explorer
e  Site -> Download Site menu option
e  C(lick the site selector drop-down and select “Download Site...”
e  Dragand Drop a URL from IE Into Contributor

The simplest approach is using the “Connect to Outlook” option. This process is described below.

Step 1: IE Toolbar button “Connect to Outlook”

Navigate to a SharePoint List or Library in Internet Explorer Click the yellow “Connect to Outlook” icon on the toolbar

é Project Emails and Documents - Windows Internet Explorer E@I
@\) - ‘g http://server/bsbev/Project%20Emails/Forms/Allltems.a v‘ ‘7‘ X ||| Live Search £ |
A - — - 5 i 5
w e ‘@ Project Emails and Documents ’ | ) v B v @ v |=hPage v {C} Tools v H
= B's Beverages > Project Emails and Documents @ Heln =
E : : /1 Send to OneNot:
| _]] Project Emails and Documents ol e o onctions
- ; &l Research
View Al Site Content | Store project emails in here to keep track of communication.
| 8 (® Connectto Outlook
Documents - - - - =
1 Sl fpoxd oo S @ Connect to Contributor
= Initiate | Type  Subject To From Proyes -

Step 2: Confirm the connection in Outlook

Contributor will start Outlook if it is not already running and confirm that you wish to connect the library to Outlook.
You may choose to connect the List ‘Online’ or ‘Cached’.

Colligo Contributor Outlook Add-in (X

| Connect this SharePoint list or library to Qutiook?
' You should only connect lists or libraries from sources that you know and trust.

http: //support. colligo.com/bsbev/Project EmailsForms/Group by Project.aspx

[ Enable local caching for this list or library

For an introduction to the difference between “Online” and “Cached” read the Contributor Add-In Cached vs Online section of this
document.

You may be prompted for credentials to connect to the SharePoint site. You may use your default Windows credentials, or supply
other specific credentials.

Login to "support.colligo.com”

),
AR

©) Use default credentials
(") Use the following credentials:

User name:

Password:

[ OK ] ( Cancel I
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If the “Connect to Outlook” process is started on a page that does not relate to a SharePoint List you will receive a message box as
shown below. Simply click OK, navigate to a List in IE and click “Connect to Outlook again.

Colligo Contributor Outlook Add-in =]

%5 An error occurred while trying to connect this SharePoint list or library

( ) S x

@7 to Outlook. Please make sure your browser is pointed at a SharePoint
list or library, rather than the home page of a SharePoint site.

http://server/bsbev/default.aspx

Step 3: Use the Contributor Add-In

Once Contributor has finished downloading the List definitions the folders are made available in Outlook.
Contributor will build out a tree for the subfolders of the selected document library.

The Online and Cached views are presented below:

Ele fdit View Go Tools Actions Help Eile Edt View Go Tooks Actions Help
piNew - é &R fSend/Receve - k s B i@k D N AQ MNew - iy §f fSend/Receve - () -89 9 N AR z
Mail «| /= 8 - Project Emails and - Colligo for Share... | « Mail «|l= B - Project Emails and - Project Emails a...
I B Beverages > Project el and Doaments ‘= o ~ B's Beverages > Project Emails and Document A
1 = o ] Inbox i il °
5 Unreaa Mal Project Emails and Documents 3 I o i | - Project Emails and Documents g
3 Sent tems o to keep track of o ° =) sent Rems View Al sits Content . ar ©
Ma Foiders 2 ||| v - | uplosd | Fiter - e by Subject g Mait Folder 2 3
2] Al Msit ems. - Name Subject  From 2] Al Mad ems. £
22 Malos D o L Emal Archwve. 22 Maibar Dae -
= 3 Coligo fo SharePlnt 3 Reaurenent Doamens 2 = 13 Colbg forShaseront - e
52 & Beverages - poject mais and | | | @) roectdocx o Ssaapteh S A g 3[4 8's Beverages - Project Emais and. ;J ;
R e et Soceteoonans s ———— s oot
e B]rgagement Mansgeren Windon SherePont Services s @ bindons Shrsbont
o he Rebiined )7 Case sy -shart . Windoms SharePont Services. v 3 To B¢ Retained Services Admn =
(22 Recurements Doaumets &) estons Completon e, Windons Sharepont seves, Y [ Réuiements Dociments e yednasusrors| | ¥
N “ et A i
24 atts S Fredsnith 1956007 11... CeebratonlurchFrdsy  FredSmith en L] B 2 St e B R
1 red Smth_150ct07 225... CelebratonLuchFrday  Fred e H ) e £k 3 (Cudeatnlisth s Fredsmth i
) Searchtietworking.com ... Last chance o 3o 60,000 pe... Searchiletworkng.com Barr & (3 Outbox Friday
1 Jm St 2230007 12... Lotest e Repert iy Pt 5 Rss Feeas
1 Mt Schuler 22807 .. Latest Issue Report Hebrut Schuder Bart =3 sent ltems L etk ks i med
e 223007, Lot i Rt Mt e oot =]
J Helmut Schuler 223007 ... Meta Taas Issue. Helmut Schuler Bart ™ | Meta Tags lssue Heimut Schuler
‘Al folders are up to date. {3 Connected to Microsoft Exchange * Lhem Allfolders ace up to date. £3 Connected to Microsoft Exchange *

Contributor Add-In Cached —-vs- Online
Contributor Add-In functions in two ‘Modes’, Online and Cached.

If you attempt connect a list to Outlook that has already been synchronized in Cached Mode Outlook will present the SharePoint
View of the list, however the list will remain synchronized in Cached Mode.

Online Mode

Key functionality of Contributor Add-In operating in Online Mode is:
e Does not maintain a cache of data

e Upload content to SharePoint with metadata Prompt

e View the SharePoint site in Outlook

e Navigate through SharePoint site using Outlook folder tree

e Automatically extract Email metadata (To, From, Sent, Subject, etc)

Cached Mode

Key functionality of Contributor Add-In operating in Cached Mode is:
e  Contentis cached providing offline access
e  Upload content to SharePoint with metadata Prompt
e Access and Edit existing SharePoint content including accessing metadata.
e Automatically extract Email metadata (To, From, Sent, Subject, etc)

April 14, 2010 Copyright 2010 Colligo Networks, Inc. All rights reserved.
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Editing content in Cached Mode

Select the folder in Outlook to access the Contributor Add-In Cached-View of the List.

e  The Cached view provides access to the content. Here you can work with your content and perform the actions highlighted
below:

e  Open adocument by double-clicking on the item
e Right-click on an item to:
o  Edit the properties (metadata) of the item.

o  Open/Edit a document
o  Check Out; Check In; or Discard Check Out
o Rename content
o  Delete content
[& Colligo for SharePoint - Microsoft Outlook o~ 3
i File Edit View Go Tools Actions Help Type a question for help 3
HEY - Search address books - @ H @ Ei
idNew - | 5| 47 | [ Search address boo @ Li@Bk I RE AQ 5
Mail « || (3 B's Beverages - Project Emails and Documents - Colligo for Shar... &
s Foltess 2 || B'sBeverages > Project Emails and Documents o |
[ Inbox < G =z
3 Unread Mai Project Emails and Documents S
[ sent Items Store project emails in here to keep track of communication. . - B o
Mail Folders 2 New ~ | Upload ~ | Filter ~ View: By Subject ~/|. g
2 All Mail items - Name Subject From To |
2 €5} Mailbox - Dave Mackay [ Email Archive 2 ]
= (3 Colligo for SharePoint (3 Requirements Documents =7
S BsBeverages - Project Emailsand ) 8's Project.docx Windows SharePoint Services. .. 2
2/ Easii frchie B DeleteDomains.xis Windows SharePoint Services. .. ]
[ Reference & ; G = :
3 To Be Deleted & Engagement Managemen. .. Windows SharePoint Services. ..
3 To Be Retained ase Study -short b d SharePo ervices Y
(23 Requirements Documents #1] Miestone Com (5} Edit Properties... Windows SharePoint Services. . 5
@ Deleted Items 5 B = L4 2
[ Drafts (S [ oos e Fred Smith ‘helr 2
t:} j"":"E = 14 Fred Smith_1a¢ [/ Edit with Microsoft Office Word Fred Smith helr =
unk E-Mail 2 e o] g
éomm, 1 SearchiNetwork | Check Out SearchNetworking.com Barr 3
[F5) RS Feeds i Johnsmith 2]~ —————————————————{ John Smith Bart
[ sent Items [ Helmut Schuler| | Bename Helmut Schuler Bart
S:JDH SW“», " ol | = Heimut schuler| % Delete Helmut Schuler Bart
S iz i H - 33%n07 ... Mieta Tags Tssue Helmut Schuler Bart ~
(2 ED W@ @ L . | l -
Done This folder is upto date. £3 Connected to Microsoft Exchange ~

Creating new content in Cached Mode

New content can be created by selecting the “New” option.
On SharePoint 2007 sites content can be created based on content-type templates

[& Colligo for SharePoint - Microsoft Outlook

: File Edit View Go Tools Actions Help

i A3New - | @B | 4B [ @ Search address books - @ i : @Back @
Mail «||[3 B's Beverages - Project Emails ar| ;
o o Site Templates | Other
Favorite Folders 2 > Project Emails !
[ Inbox 2 2 —
o e o Project Emails and Documents
[ sent items Store project emails in here to keep track of communica|
Mail Folders 2 || |[new ~|| upload ~ | Filter ~ Report
2] All Mail items - @) Email (Hidden Fields) Libject
2 €44 Mailbox - Dave Mackay B Email /—-ﬂ'
= 23 Colligo for SharePoint -
2 [ B's Beverages - Project Emails and ) Project Status Report
3 (23 Email Archive B Foider
[C3 Reference -
3 To Be Deleted B Engagement Managemen. .

) 171 Case Study -short b. .
2] Miestone Completion Rep...
4] 8's Beverages Requireme... B's Beverages Requir

[ To Be Retained
[3 Requirements Documents
& Deleted Items

‘% l”’:"“ 1 Fred Smith_195ep07 11.... CelebrationlunchFrf = e ;
[ Inbox is new document:
i Sl i Fred Smith_180ct07 22.5... Celebration Lunch Fri| o 1ot 2 name for this new docume
([ Junk E-Mail New Document
(3 Outbox I searchNetworking.com_2... Last chance to join 6{
) RS Feeds i1 John Smith_22Jan07 12.... Latest Issue Report —
(3 sent tems (4 Helmut Schuler_221an07 ... Latest Issue Report
‘i -_An SW“h i « | | = Helmut Schuler_223an07 ... Latest Issue Report Helmut Schuler Bart
'''' £ Helmut Schuler_221an07 ... Meta Tags Issue _ Helmut Schuler Bart ~
(@ L@@ L ] | 1

This folder is up to date. £3 Connected to Microsoft Exchange

Done
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Uploading existing content
Using “Upload Documents” menu

Existing content can be added to Contributor by selecting the “Upload” option
Contributor will prompt for metadata when the document is uploaded.

: File Edit View Go Tools Actions Help

3iNew - | & | 57 Send/Receive ~ | [ @ i@Bck @ R A AQ =
R PR e A L D 0/ MM = = S o o U o — | (] Project Emails and Documents: New ltem =]
Mail « || 2 B's Beverages - Project Emails and Documents - Colligo for Shary =
Favorite Folders 2 || B'sBeverages > Project Emails and Documents (. Network Usage Calculator xisx
[ Inbox : + 'uj O Excel Werkehet
B v Project Emails and Documents
[ sent items Store project emails in here to keep track of communication. Folder
Mail Folders 4 || | iew - ||upload ~ || Fier - View: By Subject Y, | [Browse... ]
2] All Mail Items v || | Name || 3 Upload Documents From To p—
= & roperties
= 25¥ Mailbox - Dave Mackay || | 3 Email Archive ContaitTyee: S =
= [ Colligo for SharePoint | | 3 Requirements Documents e [EmaM ) v]
=) [ B's Beverages - Project Emails and ) 8's Proj Name *
= (3 Email Arch )
d:zd:m*vc: & Deletep| () Upload Documents Network Usage Calulator.isx
[ To Be Deleted %E"g“ge Lookin: |}/ Project Dol - 02 Project #
B2 To e Retaind ] : _ . _phoione) <)
[ Requirements Documents ] Milestor| = Name Emmacki )| Aype ke
@ Deleted items ]85 Bevd - i
@2 Im:ns A Fredsnly RECCMtPIaces @A \p yeting Datasheet sk
—; }'l'mz"EvMa“ ] Fred s - £1] Capabilities.pptx
[ Outbox i search i) Capabilities Notes.docx
(5] RSS Feeds £ John snf Usskiop
[ sent Items 4 Helmut ™
= i
@ 3 Spam vl | & Helmut L1
A Heimut  Dave Mackay
EETEIRETE [ .
LY
Deone
t Computer
[ W
<.
Network

Fil name: Network Usage Calculatorxisx -

Flesoftype:  [AlFies () 0] [Ccmel ]

Using Drag-and-Drop

Drag from your Inbox into the Outlook tree
e  Emails can be uploaded to SharePoint simply by drag-and-drop direct from your Inbox into a folder Connected to Outlook.

e Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named SharePoint columns (if they
are defined).

.msg format maintains fidelity of the message, including attachments
Unique SharePoint filename generated based on Sender, Sent, and, Subject

() Inbox - Microsoft Outlook

Recycle Bin : File Edit View Go Tools Actions Help

 SANew - | B 23 X | GuReply GRReplytoAll G Forward | B2 Y | G | [ Search address 53] Project Emails and Documents: New Item =]
- = Document
_ «
g Mail Inbox 1 Genese Castonguay_19Aug07 21.56.24_The Dally 451 Salesforce...
[ Favorite Folders 2 [{[search nbox < ;
=< o) - 2
b - Bmbox. Arranged By: Date Newest o
Colligo L Unread Mail Folder
Contribut... [ sent items B Three Weeks Ago ‘a/ ‘ [(Bromse... |
Mail Folders 2 3 Mi ft Custs S t 07/02/2
[ icrosoft Customer Suppol Properties
2] All Mail Items Co your e-mail address for W s Li i
= _ Content Type: [Emal (ridden Fields) -
= €5 Mailbox - Dave Mackay A || =4 Windows Live ID 07/02/2
= [ Colligo for SharePoint Welcome to Windows Live ID a

= [ B's Beverages - Project Emails and

Genese Castonguay_19Aug07 21.56.24_The Daily 451 Salesforce.c
= _J Email Archive se’

[ Reference < m Project #
o= <2l D3yd Whitehead 01/10/2q

[ To Be Deleted F b &% g Pt G i (None) v
[ To Be Retained

[ Requirements Documents (= Genese Castonguay 19/08/20
(3 Deleted Items The Daily 451: Salesforce.com adds a portal, Exadel, Egener:
() Drafts -4 David Whitehead 17/08/20
[ Inbox FW: Colliga Contributor Information

L@ Junk E-Mail ~ | 3 David Whitehead 13/07/29
vvvvv FW: Network usage document
(458 I ) 3 @ - § 2 NeTBriefing 05/04/2

All folders are up to date. £3 Connected to Micr|
Network

|
{kage Cae-

7 ProjectEmaneand | (@ Inbox - Microsoft O...
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Drag from your Desktop into the Contributor Cached View

e  Files or Folder structures can be uploaded to SharePoint simply by drag-and-drop direct from your Desktop (or My Computer)
into the Contributor Cached View in Outlook

e Contributor will prompt for metadata

e  Contributor uploads the files and folders to the selected library

Recycle Bin

 File Edit View Go Tools Actions

Help Type a question f —
2 T 53] Project Emails and Documents: New tem [=]
i 3INew - | &R | Search address books @ @Bk ® R A AQ
i Document
@ Mail « ||[1d B's Beverages - Project Emails and Docume| . Network Usage Calaulator.xisx
=" i i A || g'sBeverages > Project Emails and Documents —ﬂ B
= [ Inbox : .
Colligo Lﬁ i - Project Emails and Documents Folder
Contribut.- [ Sent Items Store project emails in here to keep track of communication. lu/ [ [ Browse... ]
Mail Folders 2 || | New + | Upload + | Fiter ~ View: | By Subject S| e
2] All Mail Items ~ || | Name Subject From  Content Type: [Email (idden Fieds) -]
= €6 Mailbox - Dave Mackay [ Email Archive
= [3 Colligo for SharePoint [ Requirements Documents Powme™
= [ B's Beverages - Project Emails and ) B's Project.doox “ Wind Network Usage Calcuiator. xisx
EI/ Email Archive ) DeleteDomains.xls AW\ Wind o Project #
[3 Reference & Len® 5
(3 To Be Deleted JEngagemen‘t -M'a:kngh... Wind (None)
[ To Be Retained ‘?_]_,.--"
[3 Requirements Documents 81 Milestone Completion Rep... wind
& Deleted Items 5] Beverages B's Beverages R ts.
tht 1D ':m - = i1 Fred Smith_195ep07 11.... Celebration Lunch Friday Fred
.
@] -J:REXE-'M” i Fred Smith_180ct07 22.5... Celebration Lunch Friday Fred
setom ¥ = om_2... Last chance to join 60,000 pe... Sear
(B E@ @@ - L ] I
Done This folderis up to date. [£3 Connected to Microsoft

Drag from your Desktop into the Outlook tree

e  Files can be uploaded to SharePoint simply by drag-and-drop direct from your Desktop (or My Computer) into the Outlook
folder tree

e Contributor will prompt for metadata

e Contributor uploads the file to the selected library

Recycle Bin

i File Edit View Go Tools Actions

Help Type a question f —=
z . — 3] Project Emails and Documents: New Item [F==]
: 3ANew - | R | Search address books @ Zi@Back @ R A|MQ
= Document
ﬁ Mail « ||[d B's Beverages - Project Emails and D (. Network Usage Calaulator xisx
L= Tenemnite ol % || B'sBeverages > Project Emails and Documents i -
[ Inbox : .
Colligo Lﬁ - Project Emails and Documents Folder
Contribut... (3 sent Items Store project emals i here fi keep Fack OF commUNICATIon: [ cal | [Browse... ]
Mail Folders 2 || | New + | Upload | Filter + View: | By Subject -l e
2] Al Mail Items ~ |l | Name Subject From  ContentType: [Email (ridden Fieis) B)
= €4 Mailbox - Dave Mackay afl | C3Email Archive
= 23 Colligo for SharePoint (23 Requirements Documents Snd:*
g3 Es Beverages - Progef ails and SJB.S Project.docx Win Network Usage Calculator.xisx
Al T = i s
= Tqi!'l;e! o &) Engagement Managemen... Wind
| a*To Be Retained =
, & Requirements Documents ] Miestone Completion Rep... wind
Gk Deleted tems ) g's Beverages Bs Beverages R t5..oo
8 ﬂ f’:"s 1 Fred Smith_195¢p07 11.... Celebration Lunch Friday Fred
nbox
(3 Junk E-Mail =1 Fred Smith_180ct07 22.5... Celebration Lunch Friday Fred|
S 1= com_2... Last chance to join 60,000 pe... Sear,
I e @kl @ L L | C
Done This folderis up to date. [£3/ Connected to Microsoft

77 Project Ematls and . T® Colligo for SharePor.
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Drag attachment from an email into the Outlook tree

e Attachments can be uploaded to SharePoint simply by drag-and-drop direct from an email into the Outlook folder tree (or
Contributor Cached View).

e Contributor will prompt for metadata

e Contributor uploads the file to the selected library

: File Edit View Go Tools Actions Help Typeaq

i 3ANew - | @ 23 X | CaReply CReplytoAll (3 Forward |H5 W | &3 | () Search address b (sl Project Emails and Documents: New Item =
Mail «‘ L3 Inbox Eadkped:
Favorite Folders N <Mutiple Fles>
R b = . & % |5 Bxended Benefits Forms - Message (HTML) .\‘ ST
- C‘:”'g”t LS ;J"':;d Ml Message | Add-ns Filder
ontribut... U= Sent Items e
Browse...
" Mail Folders | 3 3 x 25+ ||| & | | B categorize - 5 [u/ =
i i [ S ¥ Eoliow Up~ Properties
L] Al Mail tems Reply Reply Forward | Delete Junk e Find mERE l )
= - -l ym n ontent Type:  [Project Status Report -
= 5% Mailbox - Dave Mackay toAll E-mail v (2 Mark as U"’“:’.
=) [ Colligo for SharePoint Respond Adtions Options X e

El L_j;‘ :m";l’: From: Christa Taylor [Christa@8eanheads.com] Sent: Tue 2 ‘
e I Tor David Whitehead
[ Refelg v.
[ To Be Deleted
[ To Be Retained -
[ Requirements Documd | Messagg
(@) Deleted Items

ce
'Sab)’eg: Extended Benefits Forms

0]Heath Enrollment Info.xls (40 KE)
7 MSP Group App.pdf (111 KB)

[7) Drafts
[ nbox | "2 EHC Claim form.pdf (63 KB)
(g Junk E-Mail
""" Hi Dave,
e L] - L
ttached are the forms per our discussion [T} show all available properties
11 ltems

Network
Usage Calcu..

If you want to fill them out with the updated information | will take it from|

"

7 Project Emails and ... Tnbox - Microsoft O...

- B Extended BenefitsF... <BE

Using Send and File

e  Automatically store a copy of a sent email using the Send & File command in the Colligo Send & File toolbar

e  Select the destination SharePoint location using the Colligo for SharePoint folders in the Outlook folder tree

e  Filing Advisor suggestions locations based or recently used folders or email conversation.

e  Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named SharePoint columns.
e .msg format maintains fidelity of the message, including attachments

e Unique SharePoint filename generated based on Sender, Sent, and, Subject

AR T - - b " Untitled - Message (HTML)

al
—/ Message Insert Options Format Text Add-Ins

== (38 & 02 g4 ﬁ
= v 4
EE | | | pl g E
Send Settings Paste 7 |B I u”éb/ A || = | Address Check - Upload Ins'ert Ru

& File Book Mames
Colligo Send & ...|| Clipboa.. = Basic Text MNames Inclu.. Colligo Attachme

'

[ Ly !
2= - - |[+—
w )\ - |A a7z

Double-click a folder to Send File X

Recent Folders | Folders Used In This Conversation ]

rColligo for SharePoint\B's Beverages - Initiate |

Select a Colligo For SharePoint Falderik

= Mailbox - Dave Foster
& [ Colligo for SharePoint
1 B's Beverages - Initiate
|_1 B's Beverages - Project Announcements
3 [ B's Beverages - Project Emails and Documents
B [ Closed Items for 41224
B [ Status Reports
[0 week 1
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Using Copy Folder
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e  Folders and their contents (including sub-folders) from your Mailbox can be uploaded to SharePoint using the Copy folder
command in the Colligo toolbar

e Acorresponding folder tree is created in SharePoint and the individual emails are uploaded.

e  Contributor automatically extracts email metadata (To, From, Sent, Subject, etc) to similarly named SharePoint columns.

e .msg format maintains fidelity of the message, including attachments

. Unique SharePoint filename generated based on Sender, Sent, and, Subject

Copy Cutleck Folder &l
Select Folder to qqu Select Destination
1 Co or 5 i = 3 Colligo for SharePaint i
|1 Deleted Items [ B's Beverages - Initiate
3 Drafts [ B's Beverages - Project Announcements
3 Inbox = [ B's Beverages - Project Emails and Documents
[ Junk E-mail [d Closed Items for 4122-4
1 Meeting Responses I [ Email Archive
[ NRC-TRAP [ Reference
[ Outbox = [ To Be Deleted =
[ Patents [ To Be Retained [
L Sent Items [ Requirements Documents
= [ Spam = 1 Status Reports
3 Allowed Senders A week 1
[ Blocked Senders [ week 2
3 Quarantine [ Week 3
1 Sync Issues 3 SharePoint 2010 Test Site - Announcements
[ The 451 Group 8 3 sharePoint 2010 Test Site - Correspondence i
Copy Options
Include top-evel folder
[ nclude sub-folders oK

Copying existing content in Cached View

Drag-and-drop

Existing content, files or folder structures, can be copied between SharePoint document libraries or folders by a drag and drop
operation. A new copy of the files or folders is created in the destination location and Contributor will prompt for metadata. In cases
where the metadata structure in the destination library is different from the source library Contributor will make a best effort to
match and retain existing metadata values.
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Emailing content as an Attachment

Upload Attachment
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You can share content with other users by sending them a link (SharePoint URL) to the content rather than an attached file. When
creating an email there is a Contributor toolbar to upload an item and replace it with a link.

"03\ H9C e 22 0)° Untitled - Message (HTML) =@ =)
S Message | Inset  Options  FomatText ©
=0 X | e 208 @ @ £ Business Card - -

: A AECEE & | = il ¥
.J o £ ‘ Q = -5 Calendar g’ !
aste (B z By Al iE iE| Address Check | Attach Attach Upload Insert Rules | Follow Spelling
R 4 yjZnar|E == = Book Mames | File Item L Signature - Up~ -
Clipboard & Basic Tedt Mames Indud, 5 Mlligo Attachments Options || Proofing
¥ To. bevidbsbev.com - 5
(o) Tosnason 0 =)
s
S “ =
Account = | Subject /
ung: . - =
Attached: | @)testing1. doc (12 KBi 7 Etestigt docx
= E —
&l
-
|
Add... b
Destination Ske:
Ste Narne: | gi8e's Beverages
Library: [)Initiate
Folder: [34.0Test ‘
Choose Destination.
oK | Cancel | g
.

Insert SharePoint URL

You can share content from the cache with other users by using the Insert command. Insert Attachment formats the URL and inserts
it at the top of the body of the email as if it had just been uploaded. Insert Text link inserts the URL at the current cursor location for

inline URLs.

N B D N Untitled - Message (HTML) =[E] R ]
S Viessage. [ RO o @
L‘E % EaEE=1= (%) @] ﬂ ) Dsunescnd- | ﬁ @ v = ,y

33 ] Calendar v
rste (B2 w2 A | [Anates chec || Attaenataen o o0 S0 Upload Insert Rules | Follow | o | spelling
- Book Names || Filz Item ignature - ~ | -
Clipboard & Basic Text Hames Include Options | Proofing
bev@bsbev.con
| tink to SharePoint Content 557) .
- —
A | | = gfies Beverages [ dave = -
Attached: | 3] Contoso Emalls ) Test 1.doc
B 3] Initiate || Test t.bxt &
[34.0Test B Test 1.xs P
B [14.0.9 ALPHA ) Test 2.doc W
[ EmptyForhow | Test2.txt
(23 Explorer Crash Test B Test 2.ds
[ (3 Metadata Test 3] Test 3.doc
[ MyTestFolder | Test 3.txt
(3 office B Test 3.xs
B CIR32 Test
[ dave
[ TempFiles
(3 WordDocuments
3] Metadata Test Library 4
3] Project Emails and Documents
5] Project Photos
L5l Project Tracker
& § Colligo - Sales and Marketing Intranet
34 contributor ¥3.2 Release
34 Contributor v4.0 Release
3 Product Management.
-
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Attachment Rules

Contributor will prevent emails from being sent if the total size of attachments exceeds a defined limit. .If this limit is exceed then
some attachments may be removed or uploaded to SharePoint and replaced with their URLs. The current limit can be seen with the

Rules command.
G r v (B0 )7 Untitled - Message (HTML) N [ESlEHE=E)
G - =
Message Insert Optians Format Text @
=n % a3} giel Q ) S pusiness cara - 0t ﬁ A Y - :y
& N = B Caendr < '
Paste _ |[B .z w|[® Address Check || Attach Attach Upload Insert Rules | Follow Spelling
- J e Book MNames | File Item |&%Signature~ - Up~ -
Clipboard Basic Text Names Include &~ Collig ihents Options = || Froofing
To.. | |bev@bsbev.com
-
Account ~ | Subject:

Attached: | E)testingl.docc i12 KB)

Colligo Attachment Manager Rule

Your total allowable size for attachments is: 10000=] KB

Share Content with other users

Copy SharePoint URL

You can share content with other users by right-clicking on an item and selecting “Copy SharePoint URL”, URLs for the selected
item(s) are copied to your clipboard and can be pasted into many applications, files, or emails.

Drag-and-Drop
Alternatively, for users that do not have access to the SharePoint site it is possible to drag and drop files or folder structures from
the Contributor Cached View into an email, Windows folder, or other suitable application.

Options Format Text

thgo tor SharePoint - Microsof Outicok
B 71
Nte 4 - Fle Edt View Go Jooh Actions Help quest
s 4 Send/Regeive - 14 o1 Wbk d A3 AQ

Sew - G &
5 Refresh Colligo Folders 8 Connect... 3] Syncheonize., o

Clipbeard

This message Mas not been sent.

o Mail “ |4 Client Meeting Documents - Colligo for SharePoint

[ Favoeite Folden = FormD - Sy e -
1 nbox .
Subject B Uriremd St Uploaded Documents
Attached: 24 Sent ey the Slareai =
Mad Foiders % Mew = | Upload + | Filter -

2] AN Mas tems

i ;2! 3 %7 Mulbox - Pot Coleman &
;E_G: & "

2 3 fom
2 Chent Confident
- Cient Meeting D
i External Laware |
3 Generad Client D{
3 General Guidebn|
3 Goverment Reg IL’E o S
(3 Mumsn Resource] - Tioy PR
- Research Papery ||
j] ;"::u:hm XK Dslere
) Inbes
3 hunk E-Ma¥
£ sl

Gerame

iBsd gl 3@~

Allfolders ace up to date. LT Connected to Microsoft Exchange ~

P i ey
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The File Manager
Adding a Site to Contributor

It is possible to add a site to Contributor in a number of other ways, including:
e Use the “Connect to Contributor” option in Internet Explorer
e  File->New-> Download Site menu option
e  Right Click the site drop-down menu and select “Download Site...”

The simplest approach is using the “Connect to Contributor” option. This process is described below.

Step 1: IE Toolbar button “Connect to Contributor”

Navigate to a SharePoint site in Internet Explorer
Click the green “Connect to Contributor” icon on the toolbar

é Project Tracker - Windows Internet Explorer E@@
@@ v ‘@‘ http://server/bsbev/Issue%20Tracker/Fort v l ‘7| X || Live Search pe) VI‘
DA l;éprojectTracker ‘7} f2 v B v ® v [5hPage v G Tools 'm

" @ Help E

- B's Beverages > Project Tracker
| ;__]j Project Tracker § =dnictas
= ij Research
View All Site Content

Documents

| [ use this librarv to store forms, reports and emails reléﬁng to issues.
- = - [~ Connect to Outlook

1 Connect to Contributor

New ~ Upload ~ Actions ~ Settings v View:

= Initiate

Type Name Issue

Step 2: Enter your credentials

Contributor will prompt you to enter your credentials for this site. You may use default windows credentials or enter other specified
credentials.

&8 Download New Site [==]

Site: | <New Site> -

URL:  http://server/bsbev

Examples:

Server Authentication
©) Use default credentials
_) Use the following credentials:

User name:

Password:

[ Download ] [ Close J

Contributor will access the SharePoint web-services and request a list of Lists and Libraries you have access to.
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Step 3: Choose the lists to sync

Once Contributor has received the list of Lists you are able to select which Lists you which to synchronize.
You may choose to:
e Synchronize all document libraries and lists.
e Synchronize specific lists (described below)
Select the lists you wish to Synchronize by ticking the box next to the list in the “Select for Synchronization” dialog.

Step 3.1: Apply Sync-Filters
You may apply a filter to each list to restrict cached content. Available filters are
e Allfolders or specified folders. All subfolders will also be synchronized.
e Acollection of Views. Contributor will synchronize all content selected in any View.

The “Select Filters for Synchronization” process is shows below:

Select for Synchronization =]
VSR Select Filters For Synchronization [=]
Synchvonze all document lbranies and Ists
@ Synchronize the following: ) Disable Synchvonization for this Document Library
- = Synchronize Entre Document Libary.
1 Invoices
B Bl Tty  Only synchronize content based on the fallowing fiters:
] [ Miestones Syndhvonized Folders
) Do
B8 i roject Amouncenents 2 (Cvent of Sefect for Synchronization =
[ (S Project Calendar
"] (EaiProject Emaits and Documents = o Document Libraries and Lists
"] (3Project Management Links Add >> 7 Synchronize all document lbraries and ists
[ GyProject Photos e © Synchronize the following:
G2l &5 Project Track | - =
] §8Resources [ [l Mlestones
= [ (1) Open Projects
Click the checkbox to enable o disable synchonization for [} EProject Announcements
the specfied ist. y. [ @ Project Calendar I
Chedk Al Uncheck Al \l[ Fiter... ]R i [ (131 Project Emais and Documents:
! N EEETR | £ Erroectansgenentieis
[syndvonze | e (17 A8 1ssues 1My Doasf T @) Project Photos 3
[ - A .,,» G50 ot s
Sy bocments
Tl My Issues 23 Clent Docs Folder
[TIProject Status 7] (85 Resources =
Cick the checkbox to enable or disable synchronization for
the speciied st
e [ crekmr | [ unchekar | [Crite.. |
Step 4: Synchronize content
Contributor synchronizes the selected content.
Synchronization In Progress... oSy
Ste ot Site: §ifimMan ste
% §ifiMain Site Server:  (§1http:/fsupport.coligo.com/bsbey
Sl [ESEEr==)
Current List: )] Project Emals and Documents
Received: 00of 0 Sent: 0of 0 ']‘1”35 = £
Working .
— —
T Description
Concel | i
& Use this list to record and track project action items.
/] Close this! when syndhvonization conpletes Use this library to store emails related to the Contoso project
e Deliverables Use this custom list to record and track of project deliverables.
More ¥ Expenses Use this custom list to record and track project expenses.
Initiate Use this document library to share and collaborate on project ...
Folders v Invoices Use this custom list to record and track project invoices.
& Recycle Bin Metadata Test Library
@ Colligo for SharePoint Milestones Use this custom list to record and track project milestones.
$3 B's Beverages Open Projects
7] Action Rems Project Use this list to post and review project annou...
(8 Contoso Emails Project Calendar Use this events list to post and review project events such 3 ..
1] Deliverables ‘ 31 Project Emails and Documents  Store project related documentation in here to keep track of ¢...
10 Exp E | Project Management Links Use this link list to share links to sites pertinent to your project.
13 Initiate || Project Photos
10 Invoices 3l Project Tracker Use this library to store forms, reports and emails relating to is...
(13) Metadata Test Library SlResources Use this contacts list a5 a central repository of project resourc...
] Milestones
(10 Open Projects
47 Project Announcements
|_d Project Calendar s
1 item selected

Once Synchronization is complete you are ready to start working with the cached content.
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Editing content

Open a document by double-clicking on the item
Right-click on an item to:
e  Edit the properties (metadata) of the item.
e  Open/Edit a document
e  Check Out; Check In; or Discard Check Out
. Rename content
e  Delete content

=/ E
@bvlg | B Eeveage T Project Eraik ard Docomentsiy ~ [ %3 searcn 2]
File Edit View Tools Help
& Organize ~
Favorite L Name From Subject *
E Documents AonTe)
#)B's Beverages Requirements.docx John Smith B's Bever:
B Pictures
i 1 John Smith_16Marl0 12.56.32_Latest Is... John Smith Latest Issi|_
A= ) Project Status.docx John Smith Project St
41222 (14)
Fotders Y| 2 Email Archive p
8 B?"E’ages * | [ Requirements Documents
[id] Action Items‘ ) DeleteDomaine e i earu Domain ¢
‘j’ ;°|’_“°’°b|5’“a"5 [AFredSmith | Edit Propetties... Celebratic
1] Deliverables
I s | HHelmutSch  open with Microsoft Office Excel Team Me
&R it A Helmut Sch| Outstand
2 Initiate
M Tvoices I Helmut Sch CheckIn Re: Outsti
(23 Metadata Test Library .| ElHemut sch Discard Check Out Latest Isst
{711 Milestones Sian Gaglan Copy SharePoint URL REOuEY
. (= Jim Dwyer Testing C
(1] Open Projects - 9
&7 Project Announcements EdKate Hoof. S Re: Outsti
7 Project Calendar ] Meta Tags Delete Meta Tag
2] Project Emails and Document: @]Milestone Completion Report.docx Helmut Schuler Milestone +
|=] Project Management Links  ~ | < | n J =
1 item selected
Creating new content
Using the New command
H " 2" B
New content can be created by selecting the “New” option.
On SharePoint 2007 site content can be created based on content-type templates.
o= Q
@bvlu <« Shared Documents » User Guides v |4y I ' Search 2

Edit View Tools Help
Edit Properties...

Open with Microsoft Office Picture Manager Modified
Edit with Microsoft Office Picture Manager ligo Contributor v3.2 Add-In - User... 7/26/2009 2:58 PM
r Check Out ligo Contributor v3.2 Client - User ... 7 009 2:55 PM
ligo Contributor v3.2 Pro - User Gu... 7, 009 2:53 PM
L Copy SharePoint URL sen-filemanager-status.png 7/26/2009 3:45 PM
I R ligo Contributor v3.2 Add-In - User... 7/26/2009 2:58 PM
NSNS ligo Contributor v3.2 Client - User ... 7/26/2000 2:58 PM
Delete ligo Contributor v3.2 Pro - User Gu... 7/26/2000 2:58 PM
New » New Dociment Gu... 7/26/2009 3:06 PM
7/26/2009 3:50 PM
Upload Documents New Folder 7/26/2000 9:21 PM
Close
(8] Calendar
(23] Documentation
[=] Links

[4] Remaining 4.0 Tasks =
[ 3] Shared Documents
(23 BIM Test
[ Licensing
(23 Product Research
(23 R4 Screenshats
(23 R4.0 Datasheet
(23 User Guides
(3 WEA Screenshot Sl 1) i ]

m
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Using the File SaveAs command

The Colligo for SharePoint root location appears in application Save As dialogs which use the standard Windows Explorer tree. Saving
a file into the Contributor location creates a new file and a metadata prompt to request the content type and associated metadata
data completes the creation process.

M
DR
mv|_ﬂ e« B's Be\reragJ b Project Emails and Documents - | 3 | | Search Project Emails and Doc... 0 |
Organize + FE @ |
v Microsoft OﬁiceW: [ Closed Items for 4122-4 ] Milestone Completion Report.docx
|i| £ Email Archive @Project Status.docx
I Favorites [ Requirements Documents @Statusfor Demo.docx
Bl Desktop (L3 Status Reports B testd.docx
| Work @J B's Beverages Requirements.docx @Jtastingl.ducx
@ Colligo for Share 1] B's Project.docx ] testingl - bevs.docx
. . il
.. Documents {E]8's Project2.docx
&) Interim Report.docx
Bl Desktop B Interim Reportb.docx |
3 Libraries i1 Meta Tags Report.dock
ZIENEL M Colligo Contributor vi 1 FileMgr - User Guide.docy] -
Save as type: [Word Document (*.docx) v]
Authors: Add an auther Tags: Add atag
[ Save Thumbnail
' Hide Folders Tools ~ [ Open | [ Cancel

Uploading existing content

Using “Upload Documents” menu

Existing content can be added to Contributor by selecting the “Upload” option:
Contributor will prompt for metadata when the document is uploaded.

[ = lE
@vv[m < Shared Documents » User Guides g - I‘f‘ l Search 2|
Edit View Tools Help
New » =
Upload Documents = 2 e difiot
# Upload Documents (=]
Close =%
. =% 7 |
E‘ rvomas \ @uv’ , « Shared Docs » R4 Screenshots | 7| | Search pel : ‘
S | (53] Shared Documents: New Item L=
. Becently Ghariged i iews v [ New Folder
B Searches Dacument
Favorite Links Name
E e 3 R4-scn-custom-large.psd
R I Ch 4 [@ R4-sen-download-site.psd
Falders “)y ecently S hangs @ R4-scn-email-on-desktop.psd Foldgj =
m Contributor V3.2 Release 2l Recent Places 2 R"'SC"'f"e"m“ﬂgﬂ'd‘e(k'i"mﬁ [User Guides l [ Browse. .. ]
34 Contributor V4.0 Release More » [@ R4-scn-filemanager-daclibs.psd e
€] Announcements Falders v % R4-sen-filemanager-icon.psd
*
78] Calendar l Shared Docs . 9 R4-sen-filemanager-list.psd Name ! :
[3] Documentation ; J Contributor 2 R4-sen-filter-view-content.psd Ré-scn-filemanager-doclibs. psd
[=] Links L Mail 3 R4-scn-folder-on-desktop.psd Title
(] Remaining 4.0 Tasks |. R3 Picture [@ Rd-sen-infopath-large psd
|3 Shared Documents B R3 Screenshots % R4-sen-manual-sync.psd
\;] BJM Test 1) R4 Screenshots 3 R4-scn-metadata-edit.psd
3 Licensing Ii Snagit @ 5 R-‘-scn-metadata.-new.psd
3 Product Research || Storage5 € R4-sen-outlook-inbox.psd
(3 R4 Screenshots @ CalliaaNeviFuahiatianzin v [ i d
‘? RAD Dat.asheet File name:  R4-scn-filemanager-doclibs. psd v | AllFiles (")
3 User Guides
[ WEA Screenshot Open
Create ] [ Cancel
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Alternatively you can drag and drop content into Contributor from your desktop. Contributor will accept one or more files or

complete folder structures for uploading. Contributor will prompt for metadata when the items are uploaded.

Ei

R4-scn-file.

P T .
@Uv\‘)(ﬁmm Documents » User Guides [ 43 ][ searcn

File Edit VieWh Tools Help

Name
] Colligo Contributor v3.2 Add-In - User
&) Colligo Contributor v3.2 Client - User

&) Colligo Contributor v3.2 Pro - User Gu.
EH]R4-scn-filemanager-status.png
2 Colligo Contributor v3.2 Add-In - User

Documents

J} Recently Changed

Colligo Contributor v3.2 Client - User
T Colligo Contributor v3.2 Pro - User Gu
&) Colligo Contributor v4.0 Pro - User Gu.,

i) Shared Documents: New Ifsm

o e

Folders 3} Rd-scn-filemanager-check-injpg
3 Contributor V3.2 Release + | IR4-sen-filemanager-upload.jpg
3 Contributor V4.0 Release AN scn-filemanager-new.jpg
£ Announcements EJ]R4N¢n-filemanager-drag jp
78 Calendar
(5] Documentation £
=] Links

2] Remaining 4.0 Tasks
(23 Shared Documents

Document

Gy s flemanager-chedn.psd

Folder

3 JUser Guides Bromwse...

Properties.

Nome *
Ra-scr-filemanager-chack-n.psd

Copying existing content

Drag-and-drop

Existing content, files or folder structures, can be copied between SharePoint document libraries or folders by a drag and drop
operation. A new copy of the files or folders is created in the destination location and Contributor will prompt for metadata. In cases
where the metadata structure in the destination library is different from the source library Contributor will make a best effort to

match and retain existing metadata values.

Share Content with other users

Copy SharePoint URL

You can share content with other users by right-clicking on an item and selecting “Copy SharePoint URL”, URLs for the selected
item(s) are copied to your clipboard and can be pasted into many applications, files, or emails.

Drag-and-Drop

Alternatively, for users that do not have access to the SharePoint site it is possible to drag and drop files or folder structures from
the Contributor File Manager into a Windows folder, a file, or as an attachment to an email.
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Default Metadata and Prompting Behavior
Contributor allows you to specify default values for metadata. Default values can be set at a document library, or sub-folder level.
The default values support both inheritance and propagation.

Introducing the Metadata Dialog
A sample of the Default Metadata dialog is displayed below. The following table explains the function of the dialog.

deb s 1. List Selector Panel
{ 2
vall Apply To
[l columns Yes niton  This Folder and subfolders .
ﬁzuntads This Folder and subfolders 2 Defau It Value SEttIngs
(5] Documents. Stage Draft inition ~ This Folder and subfolders
[l = Folcer ] state FYL 8§ This Folder and subfolders
[ Folder B Status Draft g sharePoint Column Definiton  This Folder and subfolders B
o [ Email To §4 sharepoint Column Definition  This Folder and subfolders 3 Add’ Edlt and Remove
[Projects
4. Inherit propagating values from parent
items
Lo 5. Clear locally-defined values on all child
Inherit propagating values from parent items. .
[ Clear locally-defined values on all child items items
6. Prompting Behavior
List Selector Panel The List Selector allows you to change the List or Subfolder you wish to work with.

NOTE: The List selector is only visible if the dialog is access through the File menu.

Default Value Settings Name The Display Name of the SharePoint column
Value The default value to be applied.
Inherited From Indicates where Contributor receives this value from. The ‘Inherit From’ column

may take the following values:

e  SharePoint Column definition

e  <notinherited>
Parent Object Name. This may be the name of a document library of parent
folder.

Apply To Indicates whether the default value may be inherited by a subfolder. The ‘Apply
To’ folder may take the following values:
e  This Folder and subfolders
e  This Folder only

Add, Edit and Remove This buttons allow you to work with the locally-defined default values.
Multiple items can be selected for removal using the Windows standard Ctrl and Shift selection

modifiers.
Inherit propagating This folder will inherit propagating values from the parent item. Values specified with ‘This Folder
values from parent and subfolders’ are propagating values and may be inherited.
items When un-checking the option Contributor provides the option to copy inherited values locally.

Clear locally-defined
values on all child items = When settings are applied with this values checked, child-items are reset to inherit values; any user-
specified default values on child-items are cleared.

Prompting Behavior Modify the prompting behavior. The options are:
e Always: The metadata prompt will be displayed when an item is added
e Never: The metadata prompt will ¥*not* be displayed when an item is added
e According to application global settings: Prompting behavior is as defined in the View->
Options dialog
Child-items that are configured for inheritance will inherit this setting.
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Accessing the Dialog
File Menu

The file menu may offer different options according to the flavor of Contributor deployed. The Contributor interface may be
accessed by double-clicking the Contributor icon in the system tray.

(4 Colligo Contributer 31 Pro (4 Colligo Contributor Add-in 3.1 (Online)
File | site  Wew Help File | site  Wew Help
=) - | [&) sunchronize... ~ | Default Metadata Values. .. |
Open ibutor Product Demo > Docuré, Export Site Configuration... 21
Rename icuments Close
X Delete ~ | Upload ~ | Filter ~ et
MNew 3
_% Upload Documents
Folder B
| Default Metadata Values. .. o
Contributor_Release_Motes.xd
Export Site Configuration... CustomerRelationship_UserInf:
Close DiscountandDiscountiist_Userf
OpportunityRelationship_User!
Exit
J\' Columns
Lo PPN A e
Full Desktop Client Runtime Engine

* When accessed through the File menu, the Default Metadata dialog includes the List Selector Panel.

Navigation Breadcrumbs

The Default Metadata dialog may be accessed by right-clicking on the navigational breadcrumbs.

uct Demo Site + | [2] Synchronize... | @y, View Sync ssues

Collige Contributor - Product Demo Site > D’EMEDE_LM—i
uments Default Metadata Values. ..

i 5 - i
* When accessed through the breadcrumbs, the Default Metadata dialog does not include the List Selector Panel; the
dialog applies values to the selected list or subfolder.

Context Menus

The Default Metadata dialog may be accessed by right-clicking on a list in the quick launch area or on a folder in the cached view.

@ Colligo Contributor 3.1 Pro Pro
File Site  Wiew Help
site: g Contributor Product Demo = | [2) synchronize... =, t Demo - | [2) synchronize... - | @ view Sync Issues
— Contributor Product Demo > Docu Contributor Product Demo > Documents
| Documents Documents

Documents :|| Mew = | Upload - | Filter = ? * || Mew - | Upload - | Filter = View: | All Doculg

Do [HlE
A

Disable Synchronization 5 £ Folder, Open
Enable Synchronization utor_Release_MNotes.xd H ] Contri Rename

Pictu| Filter Synchronization. .. erRelationship_UserIn ] Custo ¥ Delete ook
1tandDiscountlist_Uiser] @D\scu 5, docx

s | TEE i TEER i inityRelationship_Liser } E @Oppnr Default Metadata Values... |s.dncx

= Columns énw

* When accessed through the context-sensitive menus, the Default Metadata dialog does not include the List Selector
Panel; the dialog applies values to the selected list or subfolder.
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Synchronizing Content

Contributor offers different user-configurable synchronization processes to ensure data is kept synchronized with SharePoint.
Synchronization runs silently in the background allowing you to continue working with your documents.

Automatic Synchronization processes

Colligo Contributor Options =]

Synchronize on startup
General Contributor synchronizes cached content when it starts

[V Prompt for properties when adding documents
e e Synchronize when list is viewed
When you navigate to a list the content is synchronized

Storage [ Configurable Synchronization Options I
Storage location . . . re
C:\Users\dwhitehead\AppData\Local\Coligoo | Browse... Synchronized when list is modified
Modifications include changes to the document or metadata
Synchronization
Synchronize on startup

Enable background synchronization
Contributor synchronizes content periodically. The default sync-
interval is 30 minutes.

[~]synchronize when list is viewed
[¥] Synchronize when list is modified
[¥] Enable background synchronization

Background synchronization interval: 30 minutes

[¥] Automatically download lists to resolve Site Column values

[ OK ] [ Cancel

Manual Synchronization processes
e Synchronize Specific Site:  Synchronizes the current site
e Synchronize Multiple Sites: Allows selection of specific sites to synchronize

e  Synchronize All: Synchronizes all sites defined in Contributor
e Synchronize Pending Changes: Synchronizes lists containing changed content
(&) Colligo Contributor 3.0 Professional o[5S
Fle St View Help
Site: g4 6's Beverages | |[2) synchronize... ~|| @, View Sync Issues
- o [2] Synchronize "B's Beverages” Site...
| _L % Synchronize Multiple Sites... rts
— %: Synchronize Al I
i3 Synchronize Pending Changes [ View: | All Emails -l
@8 Download New Site... oo “Project |
* Project Emails and "
Documents e .
’ i \
FrojectTrackes )  B's Beverages Requirements.... 412
M CeniRucs fulder ) Windows SharePoint Services... 4127
Pictures & Windows SharePoint Services... 412i|=
= & Windows SharePoint Services.... 4124
e 1 Celebration Lunch Friday ‘helmut@contoso.com; barb... Fred Smith
4 Celebration Lunch Friday ‘helmut@contoso.com; barb... Fred Smith 412
d MetaTags Issue Barb Sankovic Helmut Schuler i
0 TeamMeeting Barb Sankovic Helmut Schuler
4 Oustanding Issue Barb Sankovic Helmut Schuler 412;
4 Re: Oustanding Issue Barb Sankovic Helmut Schuler
= Re: Oustanding Issue Barb Sankovic Helmut Schuler 412
" Gzmnsag s 4 LatestIssue Report Barb Sankovic Helmut Schuler
= LatestIssue Report Barb Sankovic Helmut Schuler 412 _
|| < = n " »
(@ Last Synchronization: 26/02/2008 12:30:44 PM

Full Synchronization

Several of the synchronization processes allow you to specify ‘Full Synchronization”. When Contributor performs a full
synchronization additional information is downloaded, this includes definitions for Sites, Lists, Views and Content-Types, etc, plus
other site-content that may not be retrieved during other standard sync processes.
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Pending Changes Synchronization

You may review content that has changed since the last synchronization by accessing the View->Pending Changes window. For each
item with a pending change you can choose to discard the changes. Discarded changes will be reverted upon the next
synchronization.

Pending Synchronization Changes ==

| Name Site: List Modified Status & i
Elsite: B's Beverages (5)

| ) &'s Project.docx §8's Beverages (i3] Project Emails and ... 26/02/2008 2:20:59PM  Update

3 &' Beverages

DeleteDomains. xls
Engagement Management.ppt
) 171 Case Study - short_bwj.doc 34 8's Beverages (53] Project Emaills and
1) Meta Tags Report.docx §i88's Beverages [i3lProjectEmails and ... 26/02/2008 2:20:59PM  Update

23 Project Emails and ....
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Configuration

Contributor provides easy access to the common configuration options:

(@ Colligo Contributor 3.0 Professional =3 o8 =<
Be St | Vew | Heb
ste: gis] G View Synclssues o+ | @y View Sync Issues
| kosect Emais and Documents
VewpendngChanges-.  pails and Documents
"Documen{ “8 Show Eiter Choices \ here to keep track of communic
Refresh = e Colligo Contributor Options =2
| To
* Project ENEEG" e S
s Issue Report Barb Sankof el
3 Latest & Barb Sanko
* Project Tracker @_] ¥|Prompt for properties when adding documents
Cl Folde
A1k Fls 4 Re: Oustanding Issue = Use aurent Windows appearance
Pictures 4 Testing Compiets [—— Y
= = Team Meetng Needed “barb @con! Storage
Uists I LatestIssue Report Barb Sanko Storage location . -
1 Re: Oustanding Issue Barb Sanko C:\Users\dwhitehead\AppDatalLocal|Coligo | Browse...
" Re:Oustandnglse | BarbSanko
=4 Returned Mai Barry Jinks Synchronization
) Meta Tags Report.docx [Flsynchronize on startup
L)
< Synchronize when lstis viewed
i Last chance to joi 60,000 pe.. Barry Jrks i
* Open Projects | @) Project Status Report.docx V| Synchronize when st is modified
) Project Status Report.docx V] Enable background synchronization
«|le m
Background synchronizaton interval: 30 minutes
¥) Automatically dowrioad lists to resolve Site Column values
o (=

For details regarding the Synchronization options please check the Synchronizing Content section.

Prompt for properties when adding documents
By default Contributor prompt for metadata when content is added. This option allows you to disable the prompt. If the prompt is

disabled content is uploaded to SharePoint with default metadata.

Use current Windows appearance
Switch Contributor’s Ul between a Windows application look-and-feel and a WSSv3 style look-and-feel. With the Windows

appearance Contributor will adopt the underlying Windows color scheme.

Standard Appearance Windows Appearance
@ Colligo Contributor 3.0 Professional [EE]E=] @ Colligo Contributor 3.0 Professional [==E]=]
fle Ste Vew Help File Site View Help
Site: g4 B's Beverages - | [ sunchronize... ~ | @ View Sync Issues Site: §if B's Beverages - | [2) Synchronize.. « | @ View Sync Issues
— B's Beverages > Project Tracker > Client Docs Folder - B's Beverages > Project Tracker > Client Docs Folder
EE Project Tracker BT Project Tracker
Documents | [use this lbrary to store forms, reports and emais relating to issues | Documents ] [use ths lbrary to store forms, reports and emai relating to issues
New ~ | Upload - | Filter View: | All Issues =) m)| New ~ | Upload « | Filter ~ View: AllIssues -lim
Name Issue  Status Name Isswe  Status
- il
5 :‘En;ﬂ;a\ SBEZ\SEH':F Brcjest el and £ Financial Statements
= Project Tracker s, p-s‘:e;— Z :’"‘t * Project Tracker LEIE00. oec A5 pdf. com:,,
N G o ok arePoint v2 revie... Test... e e ok 8 sharePoint v2 revie... Test...
Pictures Pictures
Lists Lists
= Open Projects L = Open Projects
(@ Last Synchronization: 25/02/2008 7:58:43 PM @ Last Synchronization: 26/02/2008 2:10:28 PM

Storage location
You are able to move the Contributor cache to another location.

Automatically downloads lists to resolve Site Column values
Contributor will ensure that data for Lookup columns is also synchronized.
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